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Welcome to MTE

Meridian Terminal Emulator (MTE) allows you to use your personal computer
(PC) to access the supervisor displays in the Meridian MAX, Customer
Controlled Routing (CCR), and Network Administration Center (NAC)
applications.

New in MTE 10

MTE 10 now supports the Dynamic Host Configuration Protocol (DHCP) for the
local printer.

In Meridian MAX 9 and lower, the local printer depended on the static IP address
of the MTE PC. The local printer was created in the MTE session and linked to
the default printer configured in the MTE session. However, if the IP address of
the MTE PC changed, the MTE session lost its local printer.

In today’s LAN environment, many customers use DHCP servers to assign [P
addresses to their PCs. The result, however, is that a different IP address can be
assigned to a PC each time it is restarted.

To support DHCP with local printers, Meridian MAX 10 uses the Media Access
Control (MAC) address of the Ethernet LAN card to associate the correct local
printer with the MTE session. It uses the MAC address because LAN cards are
rarely changed and the MAC address is unique.

Note: MTE 10 cannot connect to MAX 9 or lower.

About DHCP Support

You can assign the MTE 10 PC either a static IP address or an address from a
DHCEP server. The following table summarizes the types of IP addresses
supported by various Meridian MAX/MTE combinations.

Meridian MAX 9 or lower Meridian MAX 10

MTE 9 or lower Static IP address Static IP address
MTE 10 Not supported Static IP address or
address from DHCP
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Welcome to MTE

Local printers created in Meridian MAX 9 or lower do not support DHCP. PCs
running any version of MTE to connect to Meridian MAX 9 or lower must be
assigned a static IP address. This also applies to the MTE PC that needs to
connect to Meridian MAX 10 and Meridian MAX 9 or lower simultaneously. If
you need to connect the PC to MAX 10 and MAX 9 simultaneously, both

MTE 10 and MTE 9 must be installed in the PC and the PC must be assigned a
static [P address.

When MTE 10 is connected to Meridian MAX 10 for the first time, any printer
that was created prior to MAX 10 is automatically prepared to support DHCP.
Once this conversion is completed, MTE 9 or lower cannot use the local printer.

You can continue to use the static [P address, or you can switch between the static
IP address and DHCP.

Note: DHCP applies only to the MTE PC. You must still assign a static IP
address to the Meridian MAX server.

Limitations

There are a few limitations for MTE 10. These include the following:

e Only local printers created in Meridian MAX 10 using MTE 10 support
DHCP.

*  Local printers created prior to Meridian MAX 10 or created in Meridian
MAX 10 using MTE 9 or lower do not support DHCP.

e You must still assign a static IP address to the Meridian MAX server.

e Once the local printer is converted to support DHCP, MTE 10 must be used
to receive print jobs for this local printer.

*  MTE 10 cannot be used with releases less than Meridian MAX 10.

Ongoing and enhanced MTE features

The features offered in previous versions of MTE are continued in MTE 10.
These features allow you to do the following:

*  Use a graphical user interface while working with the agent status displays.
Note: This feature is available only in MTE 9 and above, running with
Meridian MAX 9 and above. If you are using MTE 9 with Meridian MAX 8
or lower, the displays are shown as a VT220 terminal emulation.

*  Use MTE to access NAC. NAC allows you to monitor multiple Meridian
MAX sites from one central location. This features requires MTE 9 or above.
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Send Meridian MAX reports to any printer supported by your PC. The
printer can be directly connected to the PC or accessible through a Local
Area Network (LAN). If you connect to NAC, you can also print NAC
reports to your printer.

Use context-sensitive programmable buttons to automate your navigation to
specific screens. In Meridian MAX, you can program separate buttons for each
screen. In CCR, you can program a set of buttons for use exclusively by all the
CCR screens.

Use address book entries to save different connection settings that
supervisors frequently use to connect to the Meridian MAX, CCR, or NAC.
Import or export the address books and programmable buttons.

Save data to a file for use by third-party applications.

Use a LAN, a modem, or a serial (RS-232) port to connect to Meridian
MAX, CCR, or NAC.

Open more than one MTE session on a PC running Windows 95, 98, or
2000, or Windows NT.

Customize the color of elements on your Meridian MAX supervisor screen.
Provide the equivalent of running CCR or NAC on a VT220 workstation.
Run your supervisor sessions on the same PC as the MAXcaster forecasting
tool, and send your Meridian MAX report data to a file created for
MAXCcaster.

For more information

For more information, see the following:

For Meridian MAX features, refer to the Meridian MAX 10 Supervisor'’s
User Guide (553-4001-905).

For Microsoft Windows functions, refer to the Microsoft Windows
documentation.

For CCR features, refer to the Customer Controlled Routing User Guide
(P0729367).

For NAC features, refer to the Network Administration Center (NAC) 2
Supervisor'’s User Guide (P0724352).
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Preparing the Meridian MAX or NAC

This section describes the settings that must be adjusted on the Meridian MAX or
NAC before the MTE can be used properly.

Confirming the Meridian MAX settings

To prepare Meridian MAX to run MTE 10, your system administrator or
maintenance technician must do the following:

1.

Set the terminal type in the Meridian MAX Communication Port
Assignment display to “MTE 9 or above.” This is required only if you want
to run MTE on serial ports. For more information, refer to the Meridian
MAX 10 Maintenance and Diagnostics Guide (NTP 553-4001-811),
“Configuring the Meridian MAX” chapter, “Meridian MAX Hardware
Configuration” section.

Set the Agent Status Timer field on the Miscellaneous Options display to “On
MTE 9 or higher only.” This is required only if you want to use this feature
in MTE 9 or higher. For more information, refer to the Meridian MAX 10
Supervisor'’s User Guide (553-4001-905), “Parameter Administration”
chapter, “Miscellaneous Options™ section.

Note: MTE 10 does not allow users to log on to Meridian MAX 9 or lower.

Confirming the NAC settings

To prepare NAC to run MTE 10, your system administrator or maintenance
technician must do the following:

1.

Set the terminal type in the NAC Communication Port Assignment display
to “MTE 9 or above.”
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Installing MTE 10

MTE minimum requirements

The following minimum requirements must be met to run MTE 10 on your PC:

Software/hardware Minimum requirement
Meridian MAX Meridian MAX 10
CCR * Release 3.5x (with a LAN)
* none (with a modem or serial port)
NAC * Release 2.5
Microsoft Windows One of

¢ Windows NT Release 4.0
*  Windows 95

*  Windows 98

¢ Windows 2000

Personal computer * 486 DX (for Windows 95/98 only) or
Pentium, 33 MHz IBM compatible
Note: These are the minimum
requirements. For more information, refer
to the Microsoft Windows documentation
for your operating system.

Monitor Color VGA

Free RAM 16 Mbytes for the MTE application (in
addition to the minimum requirement for
your operating system as stated in your
Microsoft Windows documentation)

Free hard disk 2 Mbytes for the MTE application (in
addition to the minimum requirement for
your operating system as stated in your
Microsoft Windows documentation)

Connection type * modem or serial (RS-232) port
e LAN with WinSock 1.1 compliant
network operating software
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To upgrade to MTE 10

Follow this procedure to upgrade to MTE 10 from MTE 9 or lower.

1.

e A

Ensure that the PC has been assigned a static IP address. For help, refer to
your Windows documentation.

Note: To upgrade, the PC must not be configured to obtain its IP address
from a DHCP server.

Install the MTE 10 software using the following procedure, “To install MTE
10.”

Note: Use the Upgrade disks rather than the New Install disks.

Connect MTE 10 to Meridian MAX 10.

Log on to the Meridian MAX Supervisor display.

Press {Control} {P} to ensure that the correct local printer is identified.
Print a report to the local printer to ensure that the local printer works.
Close the MTE session.

If the PC is configured to connect to multiple Meridian MAX 10 systems,
repeat this procedure for each Meridian MAX connection.

If you want to switch to DHCP now, configure the PC to obtain its IP address
from a DHCP server. For help, refer to your Windows documentation.

10. Once the IP address is obtained from the DHCP server, restart the PC.

To install MTE 10

Follow this procedure to install MTE 10 on your PC. Before you begin, ensure
that your computer meets the minimum requirements for MTE 10.

Note: If you are using a Windows NT or Windows 2000 system, do not log
on as a guest. This can cause problems with MTE’s installation.

Insert the MTE 10 disk labeled New Install Disk 1 into your floppy disk
drive.

On the Start menu, click Run.

The Run dialog box appears.

Type the location of your setup file.

+ Ifthe MTE 10 disk is in your drive A, type a:\setup.

Standard 1.0 6 November 2000



Installing MTE 10

» Ifthe MTE 10 disk is in your drive B, type b:\setup.

4. Click OK.
If you are installing a multilingual version of MTE, a screen appears asking
you to select a language. Ensure that the language is compatible with both
the language selected on your PC operating system and your application
(Meridian MAX, CCR, or NAC). For example, a German supervisor will use
German MTE on a German operating system.

Hortel Setup

5. Click the language in which you want MTE to run, and then click Continue.
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The next setup screen appears.

Mortel Setup |

@ Welcome to the Hortel Setup Program

Thiz program will set up MTE on your hard disk by
copying the necesszary files.

E xit

6. Click Continue.

Note: If you are upgrading from an earlier version, the setup program looks
for the older MTE release on your PC. If it is not found, the program stops

the upgrade procedure and displays an information dialog box asking you to
restart. Before restarting the installation, reinstall the older version of MTE.

The next setup screen appears.
Hortel Setup |

The zetup program will copy files into the
directory you specify.

Install Path: |E:\'HTE

Continue Exit
| I |

7. Type the path and directory:
« Ifyou want to accept the given default path and directory name, click
Continue.
»  If you want to specify a path and directory name that are different from
the default, enter them in the Install Path box and click Continue. An
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example of a valid entry for the path and directory name is D:\MTEI10.
A pop-up window appears showing the progress of the installation.
8. When prompted, insert the MTE disk requested by the setup program.
Note: The setup program prompts you to insert Disk 2.

The installation continues. When the installation is finished, the last setup
screen appears.

Hortel Setup |

@ Setup Complete

The MTE application has been zuccessfully
inztalled on your hard disk.

9. Click OK.
The window closes.
10. Remove the MTE disk from your floppy disk drive.

11. If you are upgrading from MTE 9 or lower, continue with “To upgrade to
MTE 10,” step 3, on page 6.
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Maintaining MTE 10

This section describes what you need to do to maintain the DHCP support for
local printing.

To switch between DHCP and a static IP address

From your network administrator you must obtain the directions to switch the PC
to use a static IP address or an address assigned by the DHCP server.

1. Log off the Meridian MAX, CCR, or NAC.

2. Exit MTE.

3. Follow the directions from your network administrator.

4. Restart the PC.

To replace the Ethernet LAN card

MTE 10 sends the MAC address of the Ethernet LAN card to Meridian MAX 10
so that Meridian MAX 10 can associate the correct local printer with the MTE
session.

If the Ethernet LAN card is replaced, you must do the following so that Meridian
MAX can associate the new MAC address with the local printer:
1. Reconnect MTE 10 to Meridian MAX 10.

A warning message appears to alert you that the LAN card has been changed
since the previous MTE session. You are also warned that local printers are
not accessible if you do not follow this procedure.

2. Click OK to continue.

If the PC is configured to connect to multiple Meridian MAX 10 systems,
you must reconnect with each system.
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To replace the MTE PC or hard disk

If you need to replace the MTE PC or hard disk that has MTE installed on it,
complete the following procedure:

1. Before you replace the PC or hard disk, connect MTE 10 to Meridian MAX
10 and delete the local printers.

2. Ifthe PC is configured to connect to multiple Meridian MAX 10 systems,
repeat step 1 for each Meridian MAX connection.

. Start the new PC or the PC with the new hard disk.
4. Reinstall MTE 10.
For help, see “To install MTE 10 on page 6.
Connect MTE 10 to Meridian MAX and recreate the local printers.

If the PC is configured to connect to multiple Meridian MAX 10 systems,
repeat step 5 for each Meridian MAX connection.

To uninstall MTE 10

Use the appropriate procedure for your operating system.

Windows 95/98

1. Delete all files from the directory where MTE 10 is installed.

2. On the Windows Start menu, click Run.

3. Inthe Run dialog box, type regedit and click OK.

4. Inthe Registry Editor, open the HKEY CLASSES ROOT folder.

5. Delete the MTE folder.

6. On the Windows Start menu, delete the Meridian Terminal Emulator folder.

Windows 2000 and NT 4.0

1. Delete all files from the directory where MTE 10 is installed.
On the Windows Start menu, click Run.

In the Run dialog box, type regedt32 and click OK.

In the Registry Editor, open the HKEY CLASSES ROOT on Local
Machine folder.

Cal
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5. Delete the MTE folder.
6. Ifthe MTE NEW folder is shown, delete this folder as well.
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Connecting to an application

This section describes how to use a serial port, LAN, or modem to connect to
your Meridian MAX, CCR, or NAC applications. To connect to your application,
MTE automatically uses the connection settings defined in one of the following:

e an Address Book entry defined as the system default
For more information on address books, see page 21.

e the factory default settings predefined in MTE
If a system default is not specified, MTE uses the factory default settings to
connect to your application. For more information on the factory default
settings, see page 17.

To connect using a LAN

1. Double-click the MTE icon.

The MTE window appears, displaying the Nortel Networks logo and
copyright information. The logo and copyright disappear after a few
seconds. The word “Connected” also appears in the status bar at the bottom
of the MTE window.

f;: Meridian Terminal Emulator : Unknown Host

Session Edit Seftings Help

o[8[ 8]1c| 11 | sxxloe] B]5) 2/

NCRTEL
NETWORKS
Meridian Terminal Enntiator

Supervisor Display

MTE wersion 10.21
Copyright € 2000
Mortel Mebworks

Exit F2 F3 F4 Fb F6
F7 F8 Fa F10 F11 F12
Connected LI
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Connecting to an application

2.

® NN kW

On the Settings menu, click Edit Options.
The Options dialog box appears.

Alias Mame: | Unknown Host j

CCH Toronto
treal

-~ Connection
to
Liver

& COMA co
 COM 2 Unknown Host e

ol LANI 5] e aster

[IF Address]

— Connection Speed — Emulation Type
'
€ 2400 Baud PSS
WAL
&+ 3600 Baud ¢ CCR
[k | Cancel | Make Qefaultl Help

Select an address from the Alias Name drop-down menu.
In the Connection Type area, click LAN.

In the IP Address box, type the IP address.

In the Emulation Type area, click MAX, CCR, or NAC.
Click OK to return to the MTE window.

Wait for your PC to connect to the Meridian MAX, NAC, or CCR.
If the connection is successful, the Meridian MAX, CCR, or NAC logon

Screen appears.

Log on to your application, typing your ID and password when prompted.

Your Meridian MAX, CCR, or NAC main menu appears.
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Connecting to an application

To connect using a serial port

1.

NS w» e

Double-click the MTE icon.

The MTE window appears, displaying the Nortel Networks logo and
copyright information. The logo and copyright disappear after a few
seconds. The word “Connected” also appears in the status bar at the bottom
of the MTE window.

On the Settings menu, click Edit Options.
The Options dialog box appears.
In the Connection Type area, click COM 1 or COM 2.

Note: Do not assign MTE to the same port used by the printer or other
devices.

In the Connection Speed area, click 9600 Baud.

In the Emulation Type area, click MAX, NAC, or CCR.

Click OK to return to the MTE window.

Wait for your PC to connect to the Meridian MAX, CCR, or NAC.

If the connection is successful, the Meridian MAX, CCR, or NAC logon
screen appears.

Log on to your application, typing your ID and password when prompted.

Your Meridian MAX, CCR, or NAC supervisor main menu appears.
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To connect using a modem

1.

AN AN S

10.

Double-click the MTE icon.

The MTE window appears, displaying the Nortel Networks logo and
copyright information. The logo and copyright disappear after a few
seconds. The word “Connected” also appears in the status bar at the bottom
of the MTE window.

On the Settings menu, click Edit Options.

The Options dialog box appears.

In the Connection Type area, click COM 1 or COM 2.
In the Emulation Type box, click MAX, NAC, or CCR.
Click OK to return to the MTE window.

At the modem prompt, type at&f and press Enter.

The modem responds with OK.

Type atdt and the phone number and press Enter.

Use commas where you want the modem to pause for two seconds during
dial-up. For example, to dial 9-555-1212 where a 9 is dialed to obtain an
outside line, type atdt 9,5551212.

For more information on dialing in to a remote site, refer to your modem
documentation.

The system dials the number you have entered.
Wait for the modem to indicate that you are connected.

Once you are connected, you might be asked to specify the display type that
you are using.

Specify the display type that you are using:

+ Ifyou are connecting to Meridian MAX 10 or above, or NAC 2.5, select
MTE 9 or above.

* Ifyou are connecting to CCR and you are prompted for a display type,
select VT220.

Log on to your application, typing your ID and password when prompted.

Your Meridian MAX, CCR, or NAC main menu appears.
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To connect using the factory default settings

MTE uses the factory default settings to connect to the Meridian MAX in the
following situations:

*  You are installing MTE for the first time.
e The system default has been deleted. MTE uses the original factory default
settings to connect to the Meridian MAX when the system default is deleted.

The factory default settings are as follows:

*  Alias Name (Unknown Host)

*  Communication Type (COM 1)

¢ Connection Speed (9600 baud)

*  Emulation Type (Meridian MAX)

e Printer Port (Windows default printer)

If you are upgrading from MTE 5 or installing MTE 10 for the first time, MTE
automatically creates the “Unknown Host” entry in the address book. This entry
contains all of these factory default settings.

If you are upgrading from MTE 6 or MTE 7, MTE still creates the “Unknown
Host” entry in the address book. However, the other values for this entry are
inherited from the system default settings created in the previous version of
MTE.

If you are upgrading from MTE 8§ or above, the address book remains unchanged.

Note: Nortel Networks recommends that you do not modify the factory
default settings.

To connect using the default settings

1. Double-click the MTE icon.

If an address book entry has not been defined as the system default, MTE
uses the factory default settings. The MTE window appears, displaying the
Nortel Networks logo and copyright information. The logo and copyright
disappear after a few seconds. The word “Connected” also appears in the
status bar at the bottom of the MTE window.

2. Wait for your PC to connect to the Meridian MAX, CCR, or NAC.

If the connection is successful, the Meridian MAX, CCR, or NAC logon
screen appears.
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Connecting to an application

3. Log on to your application, typing your ID and password as prompted.
Your Meridian MAX, CCR, or NAC main menu appears.

To fix a connection problem

If you experience problems connecting to your Meridian MAX, CCR, or NAC,
try the following:

e Ask your system administrator to check that Meridian MAX, CCR, or NAC
is running, then click Restart to reestablish the connection.

*  Ask your network administrator to check that the network software is
configured correctly.

*  Make certain that the port used by MTE is not used by the printer or other
devices.

» Ifthe PC is configured to obtain the IP address from the DHCP server,
ensure that the I[P Address is still valid. If the IP address lease has expired,
you must obtain a new [P address from your network administrator.

a. Exit MTE.
Enter the new IP address obtained from your network administrator.
For more information, see your Windows documentation.

c. Restart your computer.
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Using the MTE toolbar

MTE allows you to carry out various procedures by clicking buttons on the
toolbar. Each button represents one of the MTE menu commands. This table
describes the functions of each of the toolbar buttons.

Button

Name

Function

E

& X % B 3 2 E [=

Restart Session

Address Book

Exit

Copy

Options

Font

Customize

Buttons

Enable Buttons

Disable Buttons

Print Setup

Restarts the supervisor session.

Opens the Address Book dialog box.

Exits MTE.

Copies the highlighted text to your
clipboard.

Opens the Options dialog box.

Opens the Font dialog box.

Opens the Customize Buttons dialog box.
This button is available only when the
programmable buttons are enabled.

Enables the programmable buttons. This
button is available only when the
programmable buttons are disabled.

Disables the programmable buttons. This
button is available only when the
programmable buttons are enabled.

Opens the Print Setup dialog box. This
button is available only when MTE is
connected to Meridian MAX.

MTE User Guide
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Using the MTE toolbar

Button Name Function

|&| Print Preview Opens the Print Preview dialog box. This
button is available only if you are
connected to Meridian MAX 8.6x or
higher, and a report is ready to be

previewed.
? | About Displays version and copyright
information.
Help Displays the MTE online Help.
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This section describes how to use entries in the address book.

Address book entries contain settings to link your PC to different supervisor
sessions in the Meridian MAX, CCR, or NAC. You can save and reuse these
settings. You can create a maximum of 30 entries in an address book.

Only one address book can be active on your PC at one time. If you have more
than one MTE 10 session running on your PC, any changes made to the address
book in one session are applied to all the other active MTE 10 sessions.

To display the Address Book dialog box

The Address Book dialog box must be displayed to create or access an address
book entry. The dialog box lists all of the entries in an address book.

1. On the Session menu, click Address Book, or click Address Book on the
toolbar.

The Address Book dialog box appears. If an address book entry has been
defined as the system default, it is identified by a check mark.

Address Book Ed |

CCR Taronto Connect |
k& Mantreal
b3 Toronta Modif
Koy
bt W ancoLver 4'

Unknown Host

Bename

Delete

Cloze

Berane
D |
N
e |

Help
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To create an address book entry

1. On the Session menu, click Address Book, or click Address Book on the
toolbar.

The Address Book dialog box appears.

2. Click New.
The New Address dialog box appears.
Mew Address |

Aliaz Mame: I

— Connection Typg————— 1~ Printer Port
" COMA1 ' Printer
 COM 2 " FILE
O LaN I  Mecaster

[IP Address]

— Connection Speed — Emulation Type

2400 Baud £ MAK
" NAC
™ 9600 Baud " CCR

Cancel | tdake Cefault Help

3. Inthe Alias Name box, type a unique name to identify the address book
entry.

The name is case-sensitive and can be up to 30 characters in length.
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4.

Select a connection type:

* Ifyou want to connect to the Meridian MAX, CCR, or NAC through a
serial port or modem, click COM 1 or COM 2.

* Ifyou want to connect through a LAN, click LAN and enter the IP
address or host name of the Meridian MAX, CCR, or NAC. The LAN
button is disabled if WinSock 1.1 compliant network operating software
is not installed on the PC.

Select a connection speed:
* Ifyou are using a serial port or a modem, click 9600 baud.
+ Ifyou are using a LAN, you cannot select a connection speed.

Note: If you are connected through a serial port, the baud rate should not be
changed from the default setting of 9600 baud. Your application uses this
parameter to communicate with the supervisor displays.

Select an emulation type:

* Ifyou want to connect to a Meridian MAX, click MAX.

* Ifyou want to connect to a CCR, click CCR.

* Ifyou want to connect to an NAC, click NAC.

Select a printer port:

* If you want to print your Meridian MAX reports, click Printer.
For more information on printing reports, see page 60.

* If you want to send your Meridian MAX or NAC reports to a file, click
File and type the path and file name that you want to use.

For example, type C:\MTE\NEWFILE. For more information on
saving reports to a file, see page 54.

* If you want to use your Meridian MAX report data in the MAXcaster
forecasting tool, click MAXcaster.

For more information on saving data for MA Xcaster, see page 57.
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8.

10.

Save your record:
» Ifthis entry is to be saved but not used as the system default, click OK.

The New Address dialog box closes. The name of your new address book
entry appears in the Address Book dialog box.

« Ifthis entry is to be saved as the system default, click Make Default
followed by Yes.

The New Address dialog box closes. A check mark appears beside the
name of your new address book entry in the Address Book dialog box.
This indicates that this is the system default.
Note: When MTE is started, it automatically uses the system default to
connect to the Meridian MAX, CCR, or NAC. This address book entry
remains the system default until you select a new one. If a system default is
not assigned, MTE uses the factory defaults. For more information on the
factory default settings, see page 17.

Click Close to return to the MTE window.

To activate the new address book entry, follow the procedure described in the
“To connect to an address book entry” section below.

To connect to an address book entry

MTE must be told which address book entry to use to create a link to the
Meridian MAX, CCR, or NAC.

1.

On the Session menu, click Address Book, or click Address Book on the
toolbar.

The Address Book dialog box appears with a list of existing address book
entries.

With the alias name of the address book entry highlighted, click Connect, or
double-click the name of the entry.

The Address Book dialog box is closed. When the connection is made, the
Meridian MAX, CCR, or NAC screen appears. The name of the selected
address book entry also appears in the title of the MTE window.

Standard 1.0 24 November 2000



Using address books

To modify an address book entry

1. On the Session menu, click Address Book, or click Address Book on the
toolbar.

The Address Book dialog box appears with a list of the address book entries.
2. With the alias name of the address book entry highlighted, click Modify.
The Modify Address dialog box appears.
Modify Address

Alias Mame: System 3

— Connection Type————————————————  ~ Printer Port
© COM 1
 COM 2

4 LAN [47.235.3.25 ] fdeaster
[IP Address]

— Connection 5 peed — Emulation Type

= 2A01 B Eud @ MAx
™~ MAC
(& SE00 Baud " CCR

ak I Cahicel tdake Default Help

3. Make your changes to the address book entry.
4. Save your modifications:
o If this entry is to be saved but not used as the system default, click OK.
The options are saved and the Modify Address box closes.

« Ifthis entry is to be saved as the system default, click Make Default
followed by Yes.

The changes are saved. In the Address Book dialog box, a check mark

appears beside your address book entry to indicate that it is the system
default.
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To rename an address book entry

If an address book entry is renamed while it is in use, the new name appears in
the MTE window. If you are running other MTE sessions at the same time, the
new name does not appear until each session is terminated and restarted. If the
address book entry was the system default, it remains the system default after it is
renamed.

1.

On the Session menu, click Address Book, or click Address Book on the
toolbar.

The Address Book dialog box appears with a list of existing address book
entries.

With the alias name of the address book entry highlighted, click Rename.
The Rename Alias dialog box appears.

Hename Alias Ed

Current Aliaz Mame  MA¥ Toronta

Mew Aliaz Name I

Cancel | Help |

In the New Alias Name box, type the new name of the address book entry.
Click OK to return to the Address Book dialog box.
Click Close to return to the MTE window.
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To delete an address book entry

You cannot delete an address book entry while it is in use by MTE. If you delete
an entry that is being used as the system default, a dialog box appears asking you
to confirm the deletion. Once you delete the system default, the factory default
settings are used until another address book entry is selected as the system
default.

1. On the Session menu, click Address Book, or click Address Book on the
toolbar.

The Address Book dialog box appears with a list of existing address book
entries.

2. With the alias name of the address book entry highlighted, click Delete.
In the confirm dialog box, click Yes.
The entry is deleted from the Address Book dialog box.

4. Click Close to return to the MTE window.

To export an address book

You can export an address book from your MTE and save it into a file. This file
can then be imported by other PCs running MTE. You should not use other
applications to alter the contents of an address book file.

On the Session menu, click Export File.
2. On the Export File submenu, click Address Book.

The Save As dialog box appears.
3. Assign the directory and file name to be used to save the address book.
4. Click Save.

The selected address book is saved to the assigned directory. The system
automatically formats the address book file for use exclusively by MTE.
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To import an address book

An address book can be imported and shared by other PC users running
Microsoft Windows. Do not use other applications to alter the contents of an
imported address book file.

You must import an address book file that has been exported from MTE on a PC.

Copy the exported address book file to your PC.
2. On the Session menu, click Import File.
3. On the Import File submenu, click Address Book.
The Open dialog box appears.
Locate the directory and folder containing the address book file.
Double-click the address book file to be imported.

The selected address book is copied to MTE. If an address book is already in
use, a dialog box appears asking if you want to overwrite it.

Click Yes to confirm the import.
Click Close to return to the MTE window.
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The Agent Status Display feature allows you to monitor the status of the agents
and the queues they are servicing. You can also use this feature to reassign
agents, queues, priorities, and supervisors. With MTE 9 and higher, the agent
status displays are presented with a graphical user interface that provides pull-
down menus to replace the softkey functions used in MTE 8 or lower. This
feature is available if MTE 9 or higher is connected to Meridian MAX 9 or
higher with two exceptions. The following table summarizes the availability of
the Agent Status Display.

Table 1: Agent Status Display availability

MAX 9 MAX 10
MTE 10 Serial No supported No
MTE 10 LAN Not supported Yes
MTE 9 Serial Yes No
MTE 9 LAN Yes Yes
MTE 8 or lower Serial No No
MTE 8 or lower LAN No No

This section describes only how to navigate through the three agent status
displays using MTE 9 or 10. For detailed descriptions on the displays and boxes,
refer to the Meridian MAX 10 Supervisor'’s User Guide (553-4001-905), “Agent
Status Display” chapter.

In MTE 9 and higher, programmable buttons are not available on the agent status
displays.

Note: 1f you are running MTE 8 or lower, the agent status displays are
shown using the VT220 terminal emulation. All the other Meridian MAX
displays are presented with the VT220 terminal emulation, even if MTE 9 or
higher is used.

To use agent status displays

To access the agent status displays, follow these steps.

1. Display the Meridian MAX main menu.
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& (o]

Session Edit Seftings Help

g | 1) o) el 6]3] 2/

Report Ready 15:84:14
!

tor Another Supervisor
5. Display Definition
6. Report Definition
7. Report Preview
8. System Reports
9. Configuration Control
1A. List Management
11. Parameter Administration
12. Schedule Definition
13. Supervisor Messaging
14. Logout

Usze up and down arrows to move among menu items
and press ENTER to make a selection.

Connected

2. On the Meridian MAX main menu, select Agent Status Display.

One of three agent status displays appears. In this example, the Agent Status
Timer Display is shown.

eridian Terminal Emulator : Spstem 3

Session Edit Settings  Healtime Help

O[S BIE| 74| 2| o] 5] (@)

Report Ready 10:24:15 By
Agent Status Timer Display — Global View
ACD-DN |POSITION STATUS TIME POSITION STATUS TIMER

1098 A : 2001 ACDH 82:53
2 D : 2003 01:27

1681 : 2006 ACD 01:35
; 5008 Bii39

1092 : 2011 @3:55
: 2013 02:49

#i:-4@

1093 : 2016
: 2018

T
% o Eem
AcD |

18086 ; : 2831 ACD

Connected ML

3. To access the options to navigate around the three agent status displays, click
Real-time on the MTE menu.
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The Real-time pull-down menu appears.

n Terminal Emulator : System 3

Session Edit  Settings

Report Ready
fAgent Status T
ACD-DN | POSITI

1888
18681
1882
1883
18684

1885

1886
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A5:28
A9:42
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To monitor agents by supervisor view

The agent status displays can be shown in a supervisor or global view.

The supervisor view shows the status of all agents assigned to a specific
supervisor. The name or ID of the supervisor appears in the title status bar at the
top of the screen. The supervisor view option is not available if the agent
information is already in supervisor mode on the display.

To use the supervisor view, the Meridian 1 Position ID must be defined in the
supervisor’s profile. This also allows the supervisor to toggle between the
supervisor view and the global view. For more information, refer to the Meridian
MAX 10 Supervisor'’s User Guide (553-4001-905), “Parameter Administration”
chapter, “Supervisor Definition” section.

To view the displays in supervisor view, follow these steps.

1. On the Real-time menu, click View.
The View submenu appears.

I Emulator : System 3

Ll atal e

Report Ready

18:56:19
Agent Status T u

Lonfiguration Control

ACD-DN | POSITI Print Snap Shot STATUS TIMER
Queue Digplay

1888 HiH 2881 0T READY - Hrd
Locate Agent : 2083 25:41

Spare Positions H
1861 ) 5 2886 25:46
et Sumenpsen '@ 2088 55 :48

100832 : 2016 25:50
: 2018 LOT READY JET L)

ACDH :
1084 : 2621 7 26:27
h : 2623 0T READYEELELAH

1865 i : 2826 ACDH 26:35
A H 2828 0T READY IR b

2 : H
1886 i H 2831 CDHY 26:83

ACDH
1882 Exit Realtime Agent Display 7348 2611 rm [DE  22:27
: AICDH 26: 2613 ACDH 26:41

ACDH

GDH

[ oM 4

| Select Supervisar View

2. On the View submenu, click Supervisor View.

The data for the agents assigned to the supervisor appear in the display. The
words “Supervisor View” appear in the title bar at the top of the display.

Standard 1.0 32 November 2000



Monitoring agents

To monitor agents by global view

The global view displays the status of all the agents in the system.

To use the Global View option, the Global Statistics field must be enabled in your
supervisor profile. It is also not available if the agent information is already
shown in global mode on the display. For more information on the supervisor
profile, refer to the Meridian MAX 10 Supervisor s User Guide (553-4001-905),
“Parameter Administration” chapter, “Supervisor Definition” section.

To view the displays in global view, follow these steps.

1. On the Real-time menu, click View.
The View submenu appears.
2. On the View submenu, click Global View.

The data for all the agents appears on the display. The words “Global View”
appear in the title bar at the top of the display.

To monitor agents by ACD-DNs

The Agent Status by ACD-DN Display allows you to view the agent data sorted
by queue.

For more information on this display, refer to the Meridian MAX 10 Supervisor's
User Guide (553-4001-905), “Agent Status Display” chapter, “Agent Status by
ACD-DN Display” section.

To monitor the agents by ACD-DN, follow these steps.

1. On the Real-time menu, click Format.
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2.

The Format submenu appears.

Meridian Terminal Emulator :
Session  Edit  Settings

o s8] B[] Tt
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11:39:65 Py
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1084 ACDHY 82:26
SPARE
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1886 NOT READY

Select Agent Status Display by ACD-DMN NUM

On the Format submenu, click “by ACD-DN.”
The Agent Status by ACD-DN Display appears.
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To monitor agents by positions

The Agent Status by Position Display allows you to view the agent data sorted by
position ID.

For more information on this display, refer to the Meridian MAX 10 Supervisor's
User Guide (553-4001-905), “Agent Status Display” chapter, “Agent Status by
Position Display” section.

To monitor the agents by positions, follow these steps.
1. On the Real-time menu, click Format.

The Format submenu appears.
2. On the Format submenu, click “by Position.”

The Agent Status by Position Display appears.

eridian Terminal Emulator : System 3

Session Edit Seftngs Realtime Help

o |8 BE| 1t| 26| o] S5 2R

Report Ready CGC: LINK DOWN 11:41:54 !
Agent Status by Position Display — Global Uiew
POSITION AGENT....NAME STATUS ACD-DN:=PRI ACD-DN:PRI ACD-DN:PRI I
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To monitor agents using the position and timer

The Agent Status Timer Display allows you to view the agent data using the
position ID and timer. The timer indicates the amount of time an agent has been
doing certain types of activities.

For more information on this display, refer to the Meridian MAX 10 Supervisor's
User Guide (553-4001-905), “Agent Status Display” chapter, “Agent Status by
Timer Display” section.

To monitor the agents by position ID and timer, follow these steps.

1.

On the Real-time menu, click Format.
The Format submenu appears.

On the Format submenu, click Agent Status Timer With Positions.

The Agent Status Timer Display appears with its Timer field. The agents are
identified by position ID.

eridian Terminal Emulator : System 3

Session Edit Settings Bealtime Help
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To monitor agents using the agent name and timer

The Agent Status Timer Display allows you to view the agent data using the
agent name and timer. The timer indicates the amount of time an agent has been
doing certain types of activities.

For more information on this display, refer to the Meridian MAX 10 Supervisor's
User Guide (553-4001-905), “Agent Status Display” chapter, “Agent Status by
Timer Display” section.

To monitor the agents by agent name and timer, follow these steps.

1. On the Real-time menu, click Format.
The Format submenu appears.
2. On the Format submenu, click Agent Status Timer with Agent Name.
The Agent Status Timer Display appears with the Timer field. The agents are
identified by agent name.
:# Meridian Terminal Emulator : System 3
Session Edit Settings Realtime Help
o || R 7| fef m=[oe]m| &[2] 2|
Report Ready CC: LINK DOUN 11:44:55 !
Agent Status Timer Display — Global View
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To access the Configuration Control feature

On the Real-time menu, you can access the Configuration Control feature in
Meridian MAX. This feature allows you to adjust various options on the
Meridian 1. The Configuration Control pop-up window appears at the bottom of
the agent status display using the VT220 terminal emulation.

While you view the Configuration Control window, MTE 10 continues to update
the agent status displays. Although the Configuration Control feature uses
VT220 terminal emulation, the programmable buttons are not available with the
display.

Note: The Configuration Control feature is not available from the Agent
Status Timer with Agent Name display.

For more information on the Configuration Control feature, refer to the Meridian
MAX 10 Supervisor'’s User Guide (553-4001-905), “Configuration Control”
chapter.

To access the Configuration Control feature, follow this step.

1. On the Real-time menu, click Configuration Control.

The Configuration Control pop-up window appears at the bottom of the
agent status display.

f:zMeridian Terminal Emulator : System 3
Session Edit Settings Bealtme Help

e 11 ) R S T = D 4

Agent Status by Position Display — Global Uiew
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To print the agent status information

You can print a snapshot of the information on the agent status display that you
are viewing. The information is printed to the default printer specified in the Print
Setup option (located through the Session menu).

To print the agent status information, follow this step.

1. On the Real-time menu, click Print Snap Shot.
The snapshot of the display is captured and printed.

To monitor queues

You can switch from any of the agent status displays to a queue statistics display.
This allows you to monitor the performance of the queues.

When you view the queue statistics display, the agent status display and
Configuration Control window (if opened) are closed. The queue display is
shown using the VT220 terminal emulation.

For more information on the Queue Statistics Display feature, refer to the
Meridian MAX 10 Supervisor'’s User Guide (553-4001-905), “Queue Statistics
Display” chapter.

To access a queue statistics display, follow these steps.

1. On the Real-time pull-down menu, click Queue Display.
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A queue statistics display appears.

Meridian Terminal Emulator : System 3
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2. To return to the agent status display, press the Agent Display function key.
The agent status display appears.
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To locate an agent

In the agent status displays, you can search for an agent based on the agent ID,
position ID, or agent name.

The system can respond to the search in a variety of ways:

If the search is successful and the agent is only servicing one queue, the
matching entry appears at the top of the display.

If you are searching for an agent on the Agent Status by ACD-DN Display
and the agent is servicing multiple queues, a pop-up window appears. The
pop-up window displays a list of the ACD-DNs being serviced by the agent
in the order the agent used to log on to them. Select the ACD-DN that you
want from the list; it appears at the top of the display.

If you are searching for an agent on the Agent Status by Position Display and
the agent is servicing multiple queues, the first matching entry appears at the
top of the display.

If the search is unsuccessful, an error message appears.

Search by Agent ID

To search by agent ID, follow these steps.

1.

On the Real-time menu, click Locate Agent.

The Locate Agent submenu appears.
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eridian Terminal Emulator : Spstem 3
Session Edit Seftings IS

o |28 B[=| 7
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2. On the Locate Agent submenu, click “by Agent ID.”
The Locate Agent By Agent ID window appears.

Locate Agent By Agent ID H

Agent D ‘

0K, Cancel ‘ Help |

3. Inthe Agent ID box, type the identification number of the agent.
4. Click OK.
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Search by Agent Name

To search by agent name, follow these steps.

1. On the Real-time menu, click Locate Agent.
The Locate Agent submenu appears.

2. On the Locate Agent submenu, click “by Agent Name.”
The Locate Agent By Agent Name window appears.

Locate Agent By Agent Name B

Agent Name: ||

0K Cancel | Help |

3. Inthe Agent Name box, type the agent’s name.
Note: The Agent Name is case sensitive.

1t is possible for different agents to have the same name. If this occurs, a
secondary menu of the matching agent IDs is presented.
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Select an Agent 1D E

kore than one Agent 1D has the Agent Name specified.
Select an Agent 1D fram the following list:
2111
2333
4444
OK Cancel Help

4. Select the agent ID from the list.
5. Click OK.

Search by Position

To search by position ID, follow these steps.

1. On the Real-time menu, click Locate Agent.
The Locate Agent submenu appears.

2. On the Locate Agent submenu, click “by Position.”
The Locate Agent By Position ID window appears.
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Locate Agent By Position ID

Position 10

0K Cancel ‘ Help ‘

In the Position ID box, type the identification number of the position.

When MQA is enabled, it is possible to have an agent assigned to different
ACD-DNs. If this occurs, a secondary menu of the matching ACD-DNs is

presented.

Select an ACD-DN [ x|

The agent specified is assigned to maore than ane ACD-0MN,
Select an ACD-0OMN from the following list:

231
2334
4343

Cancel Help

4. Select the ACD-DN from the list.
5. Click OK.
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To show spare agent positions

On the Real-time menu, you can show all the spare positions on the agent status
displays. These are positions that do not have agents logged on.

To display the spare agent positions, follow these steps.

1. On the Real-time menu, click Spare Positions.

The Spare Positions submenu appears.

Wi
Format

Report Ready 2 . 21:53:33
Agent Status Configuration Contral Lobal UView !

POSITION AGENT. Print Snap Shat 1CD-DN:PRI ACD-DN:PRI ACD-DN:PRI I

Mary Lueue Display

Mary Locate Agent
MHary

[ e o e e N L L

|Show spare positions LIk i

2. On the Spare Positions submenu, click Show.

All of the spare positions appear. The Show option is not available if the
spare positions are already shown on the display.
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To hide spare agent positions

On the Real-time menu, you can hide all the spare positions on the agent status
displays. These are positions that do not have agents logged on.

To hide the spare agent positions, follow these steps.

1. On the Real-time menu, click Spare Positions.
The Spare Positions submenu appears.
2. On the Spare Positions submenu, click Hide.

The spare agent positions are hidden on the display. The Hide option is not
available if the spare positions are already hidden.

To view agents and queues for other supervisors

The Next Supervisor option allows you to monitor the queues and agents of other
supervisors assigned to your supervisory group in your profile. You can only use
this option if the Group Member Definition field is enabled in your profile and at
least two supervisors are assigned to your supervisory group. The agent status
display being viewed must also be in Supervisor View.

For more information on the Group Member Definition, refer to the Meridian
MAX 10 Supervisor'’s User Guide (553-4001-905), “Parameter Administration”
chapter, “Supervisor Definition” section.

To use the Next Supervisor option, follow these steps.

1. Check that the agent status display is in Supervisor View.

The words “Supervisor View” appear in the title bar at the top of the display
if you are in Supervisor View. If you are not in Supervisor View, follow the
steps described in “To monitor agents by supervisor view” on page 32.

2. On the Real-time menu, click Next Supervisor.

The agent data for the next supervisor in your group appears on the display.
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To exit agent status displays

To exit the agent status display feature in MTE, follow this step.

1. On the Real-time menu, click Exit Real-time Agent Display.
The Meridian MAX main menu appears.
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This section describes how to change the settings used to connect to the Meridian
MAX, CCR, or NAC.

To change settings for the current session only

MTE allows you to make ad hoc changes to the address book entry currently in
use. The changes are effective immediately. They remain effective, however, only
for the current session. The changes are lost after you select another address book
entry or terminate MTE.

1.

On the Settings menu, click Edit Options.

The Options dialog box appears to display the connection settings for the
address book entry currently in use.

If you want to use another address book entry, select it from the Alias Name
pull-down list.

Change the options.
A description of the fields is embedded in the procedure on page 22.

You cannot change the alias name of the address book entry from this screen.
You can change it only by following the renaming procedure on page 26.

Click OK.
A pop-up dialog box appears asking if you want to update the address book.
Click No.

By selecting no, you indicate that the changes are to be applied to the current
session only.
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To connect to more than one session

You can open more than one simultaneous Meridian MAX, CCR, or NAC
supervisor session on your PC. The number of available sessions depends on the
resources on your PC.

If you are using a LAN, each session that you start takes up a LAN session on
your application. If you are using a serial port and you want to run Meridian
MAX, CCR, or NAC simultaneously, you must set up a separate port for each
application.

You require a unique ID for each MTE session connected to the same Meridian
MAX.
Double-click the MTE icon.

2. If desired, change the connection settings in the Edit Options dialog box or
the Address Book dialog box.

3. Wait for your PC to connect to the Meridian MAX, CCR, or NAC in the new
session.

Log on to the application.
To start another session, repeat steps 1 to 4.
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To connect to a different application

You can connect to a different Meridian MAX, CCR, or NAC application without
terminating your current MTE session. This can be done through the Options
dialog box or the Address Book dialog box.

From the Options dialog box

1.

6.

On the Settings menu, click Edit Options.
The Options dialog box appears.

In the Alias Name box, select the alias name of the address book entry you
want to use.

Click OK.

When prompted, click Yes or No to indicate whether you want to
permanently save the changes.

Wait for your PC to connect to the Meridian MAX, CCR, or NAC in the new
session.

Log on to the application.

From the Address Book dialog box

1.

On the Sessions menu, click Address Book.

The Address Book dialog box appears.

Click the name of the address book entry you want to use.

Click Connect, or double-click the name of the address book entry.

Wait for your PC to connect to the Meridian MAX, CCR, or NAC in the new
session.

Log on to the application.
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To restart a session

This section describes how to restart a Meridian MAX, CCR, or NAC supervisor
session from within the MTE window.

Note: If you are connected to your application through a LAN, this
procedure terminates the active supervisor session. Ensure that you have
saved any changes you want to use in future supervisor sessions before
restarting the session.

If you are connected to your application through a serial port or modem, this

procedure is equivalent to redrawing your screen.

1. On the Session menu, click Restart, or click Restart on the MTE toolbar.
A pop-up window appears asking if you want to restart the session.

2. Click Yes.

If you are connected to your application through a LAN, the active
supervisor session is terminated.
If you are connected to your application through a serial port or a modem,

the link is reconnected. Your supervisor screen disappears for approximately
five seconds and reappears unchanged.
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To exit MTE

This section describes how to exit MTE. You should log off your Meridian MAX,
CCR, or NAC supervisor session before you perform this procedure.

Note: If you are connected to your application through a LAN, this
procedure terminates the active supervisor session. Save any changes that
you have made during the current supervisor session before you exit MTE.

Log off the Meridian MAX, CCR, or NAC.

2. On the Session menu, click Exit, or click Exit on the MTE toolbar.

A pop-up window appears asking if you want to exit MTE.
3. Click Yes.
The MTE window closes.

Losing a connection unexpectedly

If an MTE connection goes down unexpectedly, the system logs you off the
current supervisor session.

This occurs if you are connected through

+ alAN
* amodem
« aserial (RS-232) port connected to Meridian MAX 8.6x or higher
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This section describes how to save your Meridian MAX and NAC reports to a file
that can be used in other applications.

When you save your reports to a file, they are saved sequentially in the
subdirectory and file name specified in the File box in the Options dialog box.
For example, if you enter c:\directory\file in the File box in the Options dialog
box, your first report is saved as c:\directory\file.001. Successive reports are
saved as c:\directory\file.002, c:\directory\file.003, and so on, until
c:\directory\file.999 is reached.

If a report is sent after you reach 999, a message box appears telling you that each
new report that is sent will overwrite the final report. At this point, you can either
delete files from your subdirectory or specify a different file name. If you specify
a different file name, ensure that the first eight characters of the new file name do
not match the first eight characters of the old file name, or your new set of reports
will overwrite your existing set of reports.

File formats

If you save to a file using data stream reporting, the data is reformatted so that it
can be read by third-party software, such as spreadsheet or database packages. In
the file, specific delimiters that are recognized by third-party software are added
to the format of the report. To use this file format, you must have data stream
reporting enabled on your Meridian MAX or NAC.

If you save to a file using the Workforce Management Tool format, the data is
reformatted so that it can be read by that software. Please refer to the
documentation for your version of Workforce Management Tool to see if it
supports this format.

If you save to a file without enabling data stream reporting or Workforce
Management Tool reporting, the file is not formatted for use by third-party
software, and it cannot be read in a text editor.
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To save to a file with data stream reporting

This procedure describes how to save a report to a file specified in the address
book. The file can be used by third-party software applications.

Note: The MTE session associated with the printer must be up and running.
1. On the Sessions menu, click Address Book, or click Address Book on the
MTE toolbar.

The Address Book dialog box appears.

Click the name of the address book entry you want to use.

Click Modify.

In the Printer Port area, select File.

In the File field, type the path and file name.

Click OK to return to the Address Book dialog box.

With the name of the address book entry still highlighted, click Connect.
Wait for the PC to connect to the Meridian MAX or NAC.

Press Control+P from any Meridian MAX or NAC supervisor screen.

A e A A e

The Local Printer Control Window appears.
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ﬁg‘-Melidian Terminal Emulator : MAX Toronto

Seszion Edit Seltngs Help

o= B[E| 11| 2e| ss|oe|e] &[5 2|

PRINTER TYPE: Data Stream

1. Profile Maintenance
. Queue Statistics Display
- Agent Status Display

2
3
4
5

Monitor Another Supervisor
Display Definition

6. Report Definition
Local Printer Control Window

PRINTER NAME:
12. Schedule Definition

Use up and down arrows to move among menu items
and press ENTER to make a zelection.

13. Supervisor Messaging

14. Logout

11:54:31

iFl-Commands [E]-Edit field (T -Erase field
Exit F2 F3 F4 F5 F&
F7 F8 F9 F10 F11 F12
| Connected ML 4

10. In the Printer Type field, press the Options function key.

The Printer Models pop-up window appears.
11. Select Data Stream.

The Printer Models pop-up window disappears.
12. In the Printer Name field, type a name.

This should be a descriptive name (for example, Data Stream).

13. Press the Commands function key.

14. Select Save changes and exit.

A pop-up window appears asking you to confirm that you are about to add a
local printer to the system.

15. Type Y.

A pop-up window appears informing you that the local printer is being

added to the system.

Any reports printed to the printer created in steps 10 to 14 are saved in the
filed specified in step 5. You can import this file into a third-party software
package. Due to the delimiters added to the report file by data stream
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reporting, the report appears in its original format when it is imported by the
third-party software.

To save to a file for MAXcaster

MTE allows you to send report data from the Meridian MAX to a file that is
picked up by the MAXcaster forecasting tool.

While this option is selected, you cannot send reports to your printer. You must
be running Windows NT to run both MAXcaster and MTE on your PC.

Note: The MAXcaster option is available only if MAXcaster is installed on your
PC.

In this procedure, an existing address book entry is modified to use the
MAXcaster option. This is only one approach. You can also create a new address
book entry with the MAXcaster option enabled, or access the setting through the
Options dialog box.

Note: The MTE session associated with the printer must be up and running.
1. On the Sessions menu, click Address Book, or click Address Book on the
MTE toolbar.

The Address Book dialog box appears.

Click the name of the address book entry you want to use.

Click Modify.

In the Printer Port area, click MA Xcaster.

Click OK to return to the Address Book dialog box.

With the name of the address book entry still highlighted, click Connect.
Wait for the PC to connect to the Meridian MAX.

Press Control+P from any Meridian MAX supervisor screen.

® NNk wDd

The Local Printer Control Window appears.
9. Ensure that Workforce Mgmt Tool is selected in the Printer Type field.
10. In the Printer Name field, type a name.

This should be a descriptive name, for example, MAXcaster printer.

11. Press the Commands function key and exit the Local Printer Control
Window.

Any reports printed to the printer created in steps 8 to 11 are saved in the
MAXDATA subdirectory where the MAXcaster is installed.
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To save to a file for the Workforce Management Tool

MTE allows you to send report data from the Meridian MAX to a file that is
picked up by the Workforce Management Tool.

While this option is selected, you cannot send reports to your printer. You must
be running Windows NT to run both MAXcaster and MTE on your PC.

Note: The MAXcaster option is available only if MAXcaster is installed on
your PC.

In this procedure, an existing address book entry is modified to use the file
option. This is only one approach. You can also create a new address book entry
with the file option enabled, or access the setting through the Options dialog box.

Note: The MTE session associated with the printer must be up and running.
1. On the Sessions menu, click Address Book, or click Address Book on the
MTE toolbar.

The Address Book dialog box appears.

Click the name of the address book entry you want to use.

Click Modify.

In the Printer Port area, click File.

In the File field, type the path and file name.

Click OK to return to the Address Book dialog box.

With the name of the address book entry still highlighted, click Connect.
Wait for the PC to connect to the Meridian MAX.

Press Control+P from any Meridian MAX supervisor screen.

ARl A T

The Local Printer Control Window appears.
10. Ensure that Workforce Mgmt Tool is selected in the Printer Type field.
11. In the Printer Name field, type a name.

This should be a descriptive name, for example, Workforce printer.
12. Press the Commands key and exit the Local Printer Control Window.

Any reports printed to the printer created in steps 9 to 12 are saved in the file
specified in step 5. This file can only be read using your Workforce
Management Tool software. For more information, refer to your Workforce
Management Tool software.
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To copy text to the clipboard

This section describes how to copy a selection of text from your Meridian MAX,
CCR, or NAC supervisor screen to your Windows clipboard. Once the text
selection is in your clipboard, you can paste it into another application.

Note: MTE does not support copying graphics to your clipboard.
1. Click and drag your mouse over the text that you want to copy.
The text is highlighted.
1. On the Edit menu, click Copy, or click Copy on the MTE toolbar.

The text is no longer highlighted. You can now paste the selected text into
another application.
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This section describes how to use MTE to print your Meridian MAX or NAC
reports. This feature is not available when MTE is connected to the CCR.

You can print the following Meridian MAX or NAC reports from MTE:

* historical reports (tabular, graphical, and event log reports)

*  system reports

* real-time display snapshots

*  Configuration Control transaction logs

»  configuration reports from the Meridian MAX Capacity Configurator
(available in Meridian MAX only)

The reports are printed only if

* there is only one MTE session running on the PC,
or

» there is more than one MTE session running on the PC, but all of the MTE
sessions are connected through the LAN to a different Meridian MAX.

If the Windows printer associated with the MTE session is on, but the MTE
session is not running, reports printed to this printer will be queued in MAX/
NAC until the MTE session starts.

To print reports with Meridian MAX 10 or NAC 2.5

If you have Meridian MAX 10 (or higher) or NAC 2.5, you can send reports to
any printer supported by your PC. This can be a printer directly attached to the
PC or accessible on a network.

Note: The MTE session associated with the printer must be up and running.
1. On the Session menu, click Print Setup, or click Print Setup on the MTE
toolbar.
The Print Setup dialog box appears.
2. Select the printer you want to use.
The default is the Windows default printer.

3. To change any of the other settings in the Print Setup dialog box, refer to
your Microsoft Windows user guide.

4. Click OK to return to the MTE window.
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The Print Setup dialog box closes.

On the Settings menu, click Edit Options, or click Options on the MTE
toolbar.

The Options dialog box appears.

In the Printer Port field, click Printer (if it is not already selected).
Click OK.

Close the Options dialog box:

* If you modified the options and want to apply them to the address book
entry, click Yes.

* If you modified the options and want to apply them only to the current
session, click No.

» Ifno changes were made, close the Options dialog box.

Press Control+P from any Meridian MAX or NAC supervisor screen.

The Local Printer Control Window appears.
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10.

11.

12.

13.
14.

15.

16.

17.

18.

In the Printer Type field, press the Options function key.

The Printer Models pop-up window appears.

Select the MTE Generic Printer option.

The MTE Generic Printer option appears in the Printer Type field.

In the Printer Name field, type a name for the printer.

This should be a descriptive name, such as the name of the default printer.
Press the Commands function key.

Select Save changes and exit.

A pop-up window appears asking you to confirm that you are about to add a
local printer to the system.

Type Y.

A pop-up window appears informing you that the local printer is being
added to the system.

Create a report in Meridian MAX or NAC.

For more information on creating a report in Meridian MAX, refer to the
Meridian MAX 10 Supervisor’s User Guide (NTP 553-4001-905), “Report
Definition” chapter.

For more information on creating a report in NAC, refer to the Network
Administration Center (NAC) 2 Supervisor's User Guide (P0724352),
“Network Report Definition” chapter.

On the Meridian MAX or NAC screen used to create the report, press the
Commands function key.

Select Print this report.
The report is printed to the printer specified in the Print Setup dialog box.

To fix a printing problem

If you experience problems printing reports to a local printer, follow these steps.

1.
2.

Make certain only one MTE session is running on your PC.

Ensure that your printer is configured properly and is accessible from your
PC.

Try sending the report to the local printer again.
If the problem persists, open the Session menu and click Reset Registry.

The system automatically resets the registry in your Windows operating
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system. For detailed information on the registry, refer to your Windows
documentation.

Try sending the report to the local printer again.

If the problem persists, contact your system administrator or Nortel
Networks distributor.
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This section describes how to preview a report in MTE before printing it.
The Print Preview option is available only if

e you are connected to Meridian MAX 10 or NAC 2.5

* areport, which has been generated in Meridian MAX or NAC, is ready to be
previewed

e the report is targeted for the MTE Display

You can use MTE to preview reports generated through the Report Parameter
Definition feature in Meridian MAX or NAC provided the output device is
“MTE Display”.

For more information on this feature, refer to the Meridian MAX 10 Supervisor's
User Guide (NTP 553-4001-905), “Report Definition” chapter, “Report
Parameter Definition” section. For more information on creating a report in NAC,
refer to the Network Administration Center (NAC) 2 Supervisor's User Guide
(P0724352), “Network Report Definition” chapter.

An MTE sessions maintains only one preview report. If more than one MTE
session is running on the PC, each session maintains its own preview report.

Unlike reports targeted on the Meridian MAX for screen display, reports targeted
for viewing through MTE are destroyed when the MTE session terminates. When
the MTE session restarts, you must regenerate these reports to preview them
again.

When you select the Report Preview option from the Meridian MAX main menu,
the preview report that was generated to the VDT appears.

If a new preview report is generated through MTE, the previous preview report is
erased.

Note: This feature is not available when MTE is connected to CCR.
To preview a report

1. On the Report Definition screen, create a report by defining the report
parameters.

2. In the Output Device field on the Report Parameter Definition screen, press
the Options function key.

A pop-up window appears displaying available print options.
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3. Select MTE Display.
The pop-up window closes.
Press the Commands function key.
Select Print this report.

When the report is ready to be previewed, the print preview icon becomes
enabled on the MTE toolbar.

6. Onthe Session menu, click Print Preview, or click Print Preview on the MTE
toolbar.

The report appears in the Print Preview window.

Refer to your Microsoft Windows user guide for instructions on using the
features in this window.
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This section describes how to customize the MTE programmable buttons to

automate actions in your Meridian MAX or CCR supervisor screens. With the
press of one button, for instance, you can go directly from the Meridian MAX
main menu to a frequently used screen.

You cannot program the buttons to execute MTE dialogs or pull-down menus.
The buttons are also not available in NAC.

The changes made to the programmable buttons from one MTE session apply to
all other sessions running on the same PC.

If you are upgrading from an MTE 7 or 8 version, the programmable buttons
from that version are used in MTE 10 until you redefine them. [f MTE 10 is a
new installation or an upgrade from MTE 6 or lower, the system provides a
default set of programmable buttons for the Meridian MAX screens. The
following are the defaults:

Button Button name | Key sequence
1 Exit <F1>

2 F2 <F2>

3 F3 <F3>

4 F4 <F4>

5 F5 <F5>

6 F6 <F6>

7 F7 <F7>

8 F8 <F8>

9 F9 <F9>

10 F10 <F10>

11 F11 <F11>

12 F12 <F12>
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Applying buttons in Meridian MAX 10 or above

If you are using Meridian MAX 10 or above, you can program up to 12 different
buttons on each screen. The buttons are defined for the screen currently being
displayed in MTE. For example, if Meridian MAX screen “A” appears, the
buttons defined in the Customize Buttons dialog box are loaded only when screen
A appears. If screen B appears, you can program a new set of buttons. This
feature is called context-sensitive programmable buttons.

If you have an MTE 10 directly connected to the Meridian MAX 10, the terminal
type must be set to “MTE 9 or above” to use the buttons.

If MTE is connected through a LAN, it automatically creates the appropriate
setting.

Applying buttons in CCR

You can define a set of programmable buttons that are exclusively used when
MTE is connected to a CCR host.

The same set of 12 CCR-specific programmable buttons is used by all CCR
screens. You cannot program context-sensitive buttons for each screen.

To define the programmable buttons for CCR, MTE must be connected to a CCR
host. These buttons are used if any of the following conditions are met:

*«  MTE is connected to CCR, and the emulation type in the Options dialog box
is set to CCR

* the emulation type in the Options dialog box is set to CCR, and the MTE
connection is being established

* the emulation type in the Options dialog box is set to CCR, and the MTE
connection cannot be established due to errors
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If MTE is a new installation, the system provides a default set of programmable
buttons for the CCR screens. The following are the defaults:

Button Button name | Key sequence
1 F1 <F1>
2 F2 <F2>
3 F3 <F3>
4 F4 <F4>
5 F5 <F5>
6 F6 <F6>
7 F7 <F7>
8 F8 <F8>
9 F9 <F9>
10 F10 <F10>
11 F11 <F11>
12 F12 <F12>
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To define buttons for Meridian MAX 10 and above

To help you program a button, an example is provided in this procedure. The
example shows how to design a button to read an existing formula into the
Formula Definition screen in Meridian MAX.

1. Check your terminal type:

* Ifyou are using Meridian MAX 10 or above and a serial port, set the
terminal type to “MTE 9 or above.” Press Control+T on any Meridian
MAX screen to check the terminal type.

* Ifyouareusing a LAN connection, the terminal type is automatically set
by MTE.

2. If your programmable buttons are not displayed on the bottom of your MTE
window, on the Settings menu, click Programmable Buttons followed by
Enable, or click Enable on the MTE toolbar.

The programmable buttons appear at the bottom of the MTE screen.
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3.

Go to the Meridian MAX screen with which you want to associate the
programmable button.

Example: Display the Meridian MAX main menu.

On the Settings menu, click Programmable Buttons followed by Edit, or
click Customize Buttons on the MTE toolbar.

The Customize Buttons dialog box appears.

Customize Buttons E

— Programmable Buttons

(1]:8
1 Edit 3 4 ] B

7 g g 10 1 12 Cancel

take Default

— Content

Button Mame IFC'fl'ﬂ'J|EI

F R

Key Sequence |B<I2F|>5<I2F|><F1 »3<CR>12<C Help
Terminal Keys
<F1> il
<F2»
<F3»
<F4» ;I

In the Programmable Buttons area, click the button that you want to
customize.

The word Edit appears in place of the number of the programmable button.
The button name and key sequence currently assigned to that button appear
in the Content group box.

Example: In the Programmable Buttons area, Button 2 is selected to be
programmed. The Content area shows how the Button Name field and Key
Sequence field appear when programming is complete.
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6.

In the Button Name field, type a name for the button.

The name can be a maximum of eight characters. This name appears when
the programmable buttons are displayed in the MTE window.

Example: In the Button Name field, the name Formula is assigned.

In the Key Sequence field, type the key sequence that you want to automate.
In the Terminal Keys pull-down list, double-click any key that you want to
include in the sequence.

Use the characters <CR> to indicate a carriage return. You can select the
carriage return symbol from the Terminal Keys pull-down list.

Example: The key sequence is 6<CR>5<CR><F1>3<CR>12<CR><F1>,
To enter this sequence, do the following:
ENTER TO

6<CR> Select the Report Definition feature on the Meridian MAX
main menu. The Report Definition pop-up window appears.

5<CR> Select the Formula Definition feature on the Report Definition
pop-up window. The Report Formula Definition screen
appears.

<F1> Display the Commands window. The <F1> key should be

selected from the Terminal Keys pull-down list.

3<CR> Select the “Read an existing formula” option. The list of
existing formulas appears.

12<CR> Select the “Number of calls accepted” formula. This formula is
Number 12. The formula appears on the screen.

<F1> Close the Commands window. The <F1> key should be
selected from the Terminal Keys pull-down list.

Repeat steps 5 to 7 to customize any other buttons for this screen.

Save your programmable buttons:

* Ifyou want to use the new buttons for the current session, click OK.

When asked if you want to save the buttons as the system default, click
No.

The Customize Buttons dialog box closes, and the buttons that you
customized appear during the current session only.
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+ If you want to use the new button as the system default, click Make
Default.

The Customize Buttons dialog box closes, and the buttons that you
customized appear.

10. Repeat steps 3 to 9 to assign buttons to other Meridian MAX screens.

To define buttons for CCR

You can create only one set of programmable buttons in CCR. The same set of
buttons is available for all the screens.
Navigate to any CCR screen.

2. If your programmable buttons do not appear on the bottom of your MTE
window, click Programmable Buttons followed by Enable on the Settings
menu, or click Enable on the MTE toolbar.

The programmable buttons appear at the bottom of the MTE screen.

3. On the Settings menu, click Programmable Buttons followed by Edit, or
click Customize Buttons on the MTE toolbar.

The Customize Buttons dialog box appears.

4. In the Programmable Buttons box, click the button that you want to
customize.

The word Edit appears in place of the number of the programmable button.
The button name and key sequence currently assigned to that button appear
in the Content group box.
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5.

In the Button Name field, type a name for the button.

The name can be a maximum of eight characters. This name appears when
the programmable buttons are displayed in the MTE window.

In the Key Sequence field, type the key sequence that you want to automate.
In the Terminal Keys pull-down list, double-click any key that you want to
include in the sequence.

Use the characters <CR> to indicate a carriage return. You can select the
carriage return symbol from the Terminal Keys pull-down list.

Repeat steps 4 to 6 to assign values to the buttons.
Save your programmable buttons:

» Ifyou want to use the new buttons for the current session, click OK.
When asked if you want to save the buttons as the system default, click
No.

The Customize Buttons dialog box closes, and the buttons that you
customized appear during the current session only.

+ Ifyou want to use the new buttons as the system default, click Make
Default.

The Customize Buttons dialog box closes, and the buttons that you
customized appear.

To export programmable buttons

You can export a programmable button file from MTE and save it into a file. This
file can then be imported to other PCs running MTE. You should not use other
applications to alter the contents of the exported programmable buttons file.

Note: You must save a set of programmable buttons as the system default
before it can be exported.

On the Session menu, click Export File.

On the Export File submenu, click Programmable Buttons.

The Save As dialog box appears.

Assign the directory and file name to be used to store the programmable
button file.

Click Save.

The programmable button file is saved. The system automatically formats the
programmable button file for use exclusively by MTE.
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To import programmable buttons

A set of programmable buttons can be imported and shared by other PC users
running Microsoft Windows. Do not use other applications to alter the contents
of a programmable buttons file.

You must use a programmable buttons file that has been exported from MTE on a

PC.

Copy the exported programmable button file to your PC.

On the Session menu, click Import File.

On the Import File submenu, click Programmable Buttons.

The Open dialog box appears.

Locate the directory and folder containing the programmable buttons.
Highlight the programmable button file to be imported.

Click Open.

The selected programmable button file is copied to MTE. If a programmable
button file is already in use, a dialog box appears asking if you want to
overwrite it with the imported file.

Click Yes to confirm the import.
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Selecting your font settings

This section describes how to select the font settings used in your Meridian
MAX, CCR, and NAC supervisor screens. The size of the window changes with
the font size that you select. Based on the system fonts supported on your PC,
you might also be able to select from the following fonts: Terminal, IBM PC, and
8514 OEM. The Terminal font is available on any PC.

Note: If you have more than one MTE session running on your PC, any change
made to the font settings in one session is applied to all the other active MTE
sessions.

To select your own font settings

On the Settings menu, click Font.
2. On the Font submenu, click Select.
The Font dialog box appears.
3. Select the font and size you want to use.

Refer to your Microsoft Windows user guide for directions on using this
screen.

4. Click OK to return to the MTE window.

The new settings are used in future Meridian MAX, CCR, and NAC
supervisor sessions until they are changed.

To select the default font settings

To return to the system default font:

On the Settings menu, click Font.
2. On the Font submenu, click Default.

The font settings change to the default. The default font is used in future
supervisor sessions until you select new settings.
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Selecting your color settings

MTE allows you to access the Meridian MAX color customization feature while
you are running Meridian MAX.

This feature gives you the ability to specify the colors for each display element
on your Meridian MAX supervisor screens. For more information on
customizing colors, refer to the Meridian MAX 10 Supervisor s User Guide
(NTP 553-4001-906), “Color Customization” chapter.
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